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Abstract 
 

 

These Application Notes describe the procedures for configuring Session Initiation Protocol 

(SIP) Trunking between service provider TELUS and Avaya IP Office Release 11.0. 

 

TELUS IP Trunking Service provides PSTN access via a SIP trunk between the enterprise and 

the TELUS network as an alternative to legacy analog or digital trunks. This approach 

generally results in lower cost for the enterprise. 

 

Readers should pay attention to Section 2, in particular the scope of testing as outlined in 

Section 2.1 as well as the observations noted in Section 2.2, to ensure that their own use cases 

are adequately covered by this scope and results. 

 

TELUS is a member of the Avaya DevConnect Service Provider program. Information in 

these Application Notes has been obtained through DevConnect compliance testing and 

additional technical discussions. Testing was conducted via the DevConnect Program at the 

Avaya Solution and Interoperability Test Lab. 
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1. Introduction 
These Application Notes describe the procedures for configuring Session Initiation Protocol (SIP) 

Trunking between TELUS and the Avaya IP Office solution. In the sample configuration, the Avaya 

IP Office solution consists of Avaya IP Office 500 V2 Release 11.0, Avaya embedded Voicemail, 

Avaya IP Office Application Server (with WebRTC and one-X Portal services enabled), Avaya 

Communicator for Windows (SIP mode), Avaya Communicator for Web, Avaya Equinox for 

Windows, Avaya H.323, Avaya SIP, digital and analog endpoints. The enterprise solution connects 

to the TELUS network via the public internet. 

 

The TELUS service referenced within these Application Notes is designed for business customers. 

The service enables local and long distance PSTN calling via standards-based SIP trunks as an 

alternative to legacy analog or digital trunks, without the need for additional TDM enterprise 

gateways and the associated maintenance costs. 

2. General Test Approach and Test Results 
The general test approach was to configure a simulated enterprise site using Avaya IP Office 

connecting to TELUS via the public internet. 

 

This configuration (shown in Figure 1) was used to exercise the features and functionality tests 

listed in Section 2.1. Note: NAT devices added between Avaya IP Office and the TELUS network 

should be transparent to the SIP signaling. 

 

DevConnect Compliance Testing is conducted jointly by Avaya and DevConnect members. The 

jointly-defined test plan focuses on exercising APIs and/or standards-based interfaces pertinent to 

the interoperability of the tested products and their functionalities. DevConnect Compliance Testing 

is not intended to substitute full product performance or feature testing performed by DevConnect 

members, nor is it to be construed as an endorsement by Avaya of the suitability or completeness of 

a DevConnect member’s solution. 

 

Avaya recommends our customers implement Avaya solutions using appropriate security and 

encryption capabilities enabled by our products. The testing referenced in this DevConnect 

Application Note included the enablement of supported encryption capabilities in the Avaya 

products.  Readers should consult the appropriate Avaya product documentation for further 

information regarding security and encryption capabilities supported by those Avaya products. 

                                                                                                     

Support for these security and encryption capabilities in any non-Avaya solution component is the 

responsibility of each individual vendor.  Readers should consult the appropriate vendor-supplied 

product documentation for more information regarding those products. 
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2.1. Interoperability Compliance Testing 

A simulated enterprise site with Avaya IP Office was connected to TELUS. To verify SIP trunking 

interoperability, the following features and functionality were exercised during the interoperability 

compliance test: 

• Incoming PSTN calls to various phone types. Phone types included H.323, SIP, digital, and 

analog phones at the enterprise. All inbound PSTN calls were routed to the enterprise across 

the SIP trunk from the service provider 

• Outgoing PSTN calls from various phone types. Phone types included H.323, SIP, digital, 

and analog phones at the enterprise. All outbound PSTN calls were routed from the 

enterprise across the SIP trunk to the service provider 

• Inbound and outbound PSTN calls from/to the Avaya Communicator for Windows (SIP)  

• Inbound and outbound PSTN calls from/to the Avaya Communicator for Web (WebRTC) 

with basic telephony transfer feature 

• Inbound and outbound PSTN calls from/to the Avaya Equinox for Windows (SIP) 

• Inbound and outbound long hold time call stability 

• Various call types including: local, long distance, outbound toll-free 

• SIP transport UDP/RTP between TELUS and the simulated Avaya enterprise site   

• Codec G.711MU and G.729A 

• Caller number/ID presentation  

• Privacy requests (i.e., caller anonymity) and Caller ID restriction for inbound and outbound 

calls 

• DTMF transmission using RFC 2833 

• SIP Trunk registration and authentication 

• Voicemail navigation for inbound and outbound calls 

• Telephony features such as hold and resume, transfer, and conference 

• Fax G.711 pass-through and Fax T.38 modes 

• Off-net call forwarding 

• Off-net call transfer 

• Twinning to mobile phones on inbound calls 

 

Items are not supported or not tested including the following: 

• TELUS does not support TLS/SRTP SIP Transport. 

• TELUS supports inbound toll-free service, however there was no inbound toll-free numbers 

built in their production lab during the compliance testing. 

• TELUS supports outbound call to international numbers, however this call was not available 

in TELUS production lab during the compliance testing. 

• TELUS supports outbound call to Local Directory Assistance service 411, however this call 

was not available in TELUS production lab during the compliance testing. 

• TELUS supports outbound call to Emergency 911, however this call was not available in 

TELUS production lab during the compliance testing. 
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2.2. Test Results 

Interoperability testing of TELUS was completed with successful results for all test cases excepting 

of the observation described below: 

• Call Redirection (Transfer/Forward) using SIP Refer method - When performing call 

transfer/forward off-net using SIP Refer method, IP Office system responded to a NOTIFY 

message from TELUS with "405 Method Not Allowed". Since TELUS sent BYE to 

terminate the first call leg before sending the NOTIFY, IPO responded "405 Method Not 

Allowed" to NOTIFY. The call transfer/forward off-net was not impacted, calls were 

transferred/forwarded successfully with two-way audio. 

• SIP endpoints may indicate that a transfer failed even when it is successful - Occasionally on 

performing a transfer operation, Avaya IP Office SIP endpoints (Avaya 1100 Series 

Deskphone and Avaya Communicator for Windows) may indicate on the local call display 

that the transfer failed even though it was successful. The frequency of this behavior can be 

reduced by enabling “Emulate Notify for REFER” on the IP Office SIP Line (See Section 

5.6.2).  

• TELUS did not support multiple m-lines for the T.38 re-INVITE - For T.38 faxing call, 

Avaya IP Office sent “m: audio 0“ line in the SDP attribute of T.38 re-INVITE, TELUS 

rejected the call with “488 Not Acceptable Here” because TELUS did not support multiple 

m-lines for the T.38 re-INVITE. Therefore T.38 Fax is not supported with this solution. 

G.711 pass-through can be used for faxing.  

• Conference on Avaya Equinox soft-client - Conference on the Avaya Equinox for Windows 

soft-client is not working properly - When the attempt is made to conference active calls in 

the Avaya Equinox for Windows soft-client by “merging” the calls together, the parties are 

not joined together into conference, instead a new call is made from the first active call that 

was held by the Equinox soft-client to the second active call held by the Equinox soft-client, 

with the Avaya Equinox soft-client unable to merge the active calls together into conference. 

This issue was only seen on the Avaya Equinox for Windows soft-client. There is no current 

work-around; if the conference feature is needed on an Avaya soft-client for IP office, the 

Avaya Communicator for windows soft-client could be use until this issue is resolved by 

Avaya. This issue is under investigation by Avaya. 

2.3. Support 

For technical support on the Avaya products described in these Application Notes visit: 

http://support.avaya.com. 

 

For technical support on TELUS SIP Trunking, contact TELUS at 

http://www.TELUS.com/business/voice-networks/ip-trunking/ 

http://support.avaya.com/
http://www.telus.com/business/voice-networks/ip-trunking/
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3. Reference Configuration 
Figure 1 below illustrates the test configuration. The test configuration shows an enterprise site 

connected to TELUS through the public IP network. For confidentiality and privacy purposes, actual 

public IP addresses used in this testing have been masked out and replaced with fictitious IP 

addresses throughout the document. 

 

The Avaya components used to create the simulated customer site included: 

• Avaya IP Office 500 V2 

• Avaya embedded Voicemail for IP Office  

• Avaya Application Server (Enabled WebRTC and one-X Portal services) 

• Avaya 9600 Series IP Deskphones (H.323) 

• Avaya 11x0 Series IP Deskphones (SIP) 

• Avaya 1408 Digital phone 

• Avaya Analog phone 

• Avaya Communicator for Windows (SIP)  

• Avaya Communicator for Web  

• Avaya Equinox for Windows 

 

Located at the enterprise site is an Avaya IP Office 500 V2 with the MOD DGTL STA16 expansion 

module which provides connections for 16 digital stations to the PSTN, and the extension PHONE 8 

card which provides connections for 8 analog stations to the PSTN as well as 64-channel VCM 

(Voice Compression Module) for supporting VoIP codecs. The voicemail service is embedded on 

Avaya IP Office. Endpoints include Avaya 9600 Series IP Telephone (with H.323 firmware), Avaya 

1100 Series IP Telephone (with SIP firmware), Avaya 1408D Digital Telephone, Avaya Analog 

Telephone, Avaya Communicator for Windows/ for Web (WebRTC), and Avaya Equinox for 

Windows. The LAN1 port of Avaya IP Office is connected to the enterprise LAN (private network) 

while the LAN2 port is connected to the public network. 

 

A separate Windows 10 Enterprise PC runs Avaya IP Office Manager to configure and administer 

the Avaya IP Office system. 

 

Mobility Twinning is configured for some of the Avaya IP Office users so that calls to these user’s 

phones will also ring and can be answered at configured mobile phones. 
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Network

Signaling Server IP address: 

192.168.158.100 

Media Server IP address: 

192.168.158.100 

Avaya IP Office 500 V2

Embedded Voicemail

H.323 Endpoints 

and Soft Clients
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and Digital Endpoints

IP Office Manager

 and Application Server
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and Soft Clients
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phone and FAX
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Robin
SIP Trunk

Avaya IP Office LAN1 port IP address: 

10.10.97.40 

Avaya IP Office LAN2 port IP address:

10.10.98.14 

DID numbers: 587XXX0308, 

587XXX0309 

 

Figure 1 - Test Configuration for Avaya IP Office with TELUS SIP Trunk Service 

 

For the purposes of the compliance test, Avaya IP Office users dialed a short code of 9 + N digits to 

send digits across the SIP trunk to TELUS. The short code of 9 was stripped off by Avaya IP Office 

but the remaining N digits were sent unaltered to the TELUS system. For calls within the North 

American Numbering Plan (NANP), the user would dial 11 (1 + 10) digits. Thus, for these NANP 

calls, Avaya IP Office would send 11 digits in the Request URI and the To field of an outbound SIP 

INVITE message. It was configured to send 10 digits in the From field. For inbound calls, TELUS 

sent 10 digits in the Request URI and the To field of inbound SIP INVITE messages. 

 

In an actual customer configuration, the enterprise site may also include additional network 

components between the service provider and the Avaya IP Office such as a session border 
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controller or data firewall. A complete discussion of the configuration of these devices is beyond the 

scope of these Application Notes. However, it should be noted that SIP and RTP traffic between the 

service provider and the Avaya IP Office must be allowed to pass through these devices. 
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4. Equipment and Software Validated 
The following equipment and software/firmware were used for the sample configuration provided: 

 

Avaya Telephony Components 

Equipment Release 

Avaya IP Office solution  

▪ Avaya IP Office 500V2 

▪ Embedded Voicemail  

▪ Avaya Web RTC Gateway 

▪ Avaya one-X Portal 

▪ Avaya IP Office Manager 

▪ Avaya IP Office Analogue PHONE 8  

▪ Avaya IP Office VCM64/PRID U  

▪ Avaya IP Office DIG DCPx16 V2 

 

11.0.0.2.0 Build 23 

11.0.0.2.0 Build 23 

11.0.0.2.0 Build 56 

11.0.0.2.0 Build 3 

11.0.0.2.0 Build 23 

11.0.0.2.0 Build 23 

11.0.0.2.0 Build 23 

11.0.0.2.0 Build 23 

Avaya 1140E IP Deskphone (SIP) 04.04.23 

Avaya 9641G IP Deskphone (H.323) 6.7104 

Avaya 9621G IP Deskphone (H.323) 6.7104 

Avaya J129 IP Deskphone (SIP) 3.0.0.0.20 

Avaya Communicator for Windows (SIP) 2.1.4.0 - 297 

Avaya Communicator for Web 1.0.16.2220 

Avaya Equinox for Windows (SIP) 3.4.10.10.2 

Avaya 1408D Digital Deskphone R48 

Avaya Analog Deskphone N/A 

HP Officejet 4500 (fax) N/A 

TELUS Components 

Equipment Release 

Ribbon  C20 R19 

Oracle SBC 7.4m1p5 

 

Note: Compliance Testing is applicable when the tested solution is deployed with a standalone IP 

Office 500V2 and also when deployed with IP Office Server Edition in all configurations. 
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5. Configure Avaya IP Office Solution 
This section describes the Avaya IP Office solution configuration necessary to support connectivity 

to TELUS. It is assumed that the initial installation and provisioning of the Avaya IP Office 500V2 

has been previously completed and therefore is not covered in these Application Notes. For 

information on these installation tasks refer to Additional References Section 9.  

 

This section describes the Avaya IP Office configuration required to support connectivity to TELUS. 

Avaya IP Office is configured through the Avaya IP Office Manager PC application. From a PC 

running the Avaya IP Office Manager application, select Start → Programs → IP Office → 

Manager to launch the application. Navigate to File → Open Configuration, select the proper 

Avaya IP Office system from the pop-up window and click OK button. Log in using appropriate 

credentials.  

 

 

Figure 2 – Avaya IP Office Selection 
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5.1. Licensing 

The configuration and features described in these Application Notes require the Avaya IP Office 

system to be licensed appropriately. If a desired feature is not enabled or there is insufficient 

capacity, contact an authorized Avaya sales representative.  

 

To verify that there is a SIP Trunk Channels license with sufficient capacity, select IPOffice_1 → 

License on the Navigation pane and SIP Trunk Channels in the Group pane. Confirm that there is a 

valid license with sufficient “Instances” (trunk channels) in the Details pane. 

 

 

Figure 3 – Avaya IP Office License 
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5.2. System Tab 

Navigate to System (1) under IPOffice_1 on the left pane and select the System tab in the Details 

pane. The Name field can be used to enter a descriptive name for the system. In the reference 

configuration, IPOffice_1 was used as the name in IP Office.  

 

 

Figure 4 - Avaya IP Office System Configuration 
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5.3. LAN2 Settings 

In the sample configuration, LAN2 is used to connect the enterprise network to TELUS. 

Note: The LAN1 port of Avaya IP Office connected to the enterprise LAN (private network) is not 

described in this document. 

 

To configure the LAN2 settings on the IP Office, complete the following steps. Navigate to 

IPOffice_1 → System (1) in the Navigation and Group panes and then navigate to the LAN2 → 

LAN Settings tab in the Details pane. Set the IP Address field to the IP address assigned to the 

Avaya IP Office LAN2 port. Set the IP Mask field to the mask used on the private network. All 

other parameters should be set according to customer requirements. Click OK to submit the change. 

 

 

Figure 5 - Avaya IP Office LAN2 Settings 

 

The VoIP tab as shown in the screenshot over the page was configured with following settings: 

• Check the H323 Gatekeeper Enable to allow Avaya IP deskphones/softphones using the 

H.323 protocol to register 

• Check the SIP Trunks Enable to enable the configuration of SIP Trunk connecting to 

TELUS   

• Verify Keepalives to select Scope as RTP-RTCP with Periodic timeout 60 and select 

Initial keepalives as Enabled 

• All other parameters should be set according to customer requirements 

• Click OK to submit the changes 
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Figure 6 - Avaya IP Office LAN2 VoIP 
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5.4. System Telephony Settings 

Navigate to IPOffice_1 → System (1) in the Navigation and Group Panes (not shown) and then 

navigate to the Telephony → Telephony tab in the Details pane. Choose the Companding Law 

typical for the enterprise location. For North America, U-Law is used. Uncheck the Inhibit Off-

Switch Forward/Transfer box to allow call forwarding and call transfers to the PSTN via the 

service provider across the SIP trunk. Set Hold Timeout (sec) to a valid number. Set Default Name 

Priority to Favor Trunk. Defaults were used for all other settings. Click OK to submit the changes. 

 

 

Figure 7 - Avaya IP Office Telephony 
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5.5. System VoIP Settings 

Navigate to IPOffice_1 → System (1) in the Navigation and Group Panes and then navigate to the 

VoIP tab in the Details pane. Leave the RFC2833 Default Payload as default of 101. Select codec 

G.711 ULAW 64K, G.729(a) 8K CS-ACELP which TELUS supports. Click OK to submit the 

changes. 

 

 

Figure 8 - Avaya IP Office VoIP 
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5.6. Administer SIP Line 

A SIP Line is needed to establish the SIP connection between Avaya IP Office and TELUS. The 

recommended method for configuring a SIP Line is to use the template associated with these 

Application Notes. The template is an .xml file that can be used by Avaya IP Office Manager to 

create a SIP Line. Follow the steps in Section 5.6.1 to create the SIP Line from the template. 

 

Some items relevant to a specific customer environment are not included in the template or may 

need to be updated after the SIP Line is created. Examples include the following: 

• IP addresses 

• SIP Credentials (if applicable) 

• SIP URI entries 

• Setting of the Use Network Topology Info field on the Transport tab. 

 

Therefore, it is important that the SIP Line configuration be reviewed and updated if necessary after 

the SIP Line is created via the template. The resulting SIP Line data can be verified against the 

manual configuration shown in Section 5.6.2. 

 

Also, the following SIP Line settings are not supported on Basic Edition: 

• SIP Line – Originator number for forwarded and twinning calls 

• Transport – Second Explicit DNS Server 

• SIP Credentials – Registration Required 

• SIP Advanced Engineering. 

 

Alternatively, a SIP Line can be created manually. To do so, right-click Line in the Navigation Pane 

and select New → SIP Line. Then, follow the steps outlined in Section 5.6.2. 

 

For the compliance test, SIP Line 17 was used as trunk for both outgoing and incoming calls. 
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5.6.1. Create SIP Line from Template 

This section describes the steps to create a SIP line from the template as follows: 

1. Create a new folder in computer where Avaya IP Office Manager is installed (e.g. 

C:\TELUS\Template). Copy the template file to this folder. The template file for the 

compliance test is TLRIPO11.xml (for SIP Line 17). 

2. Import the template into Avaya IP Office Manager: From Avaya IP Office Manager, select 

Tools → Import Templates in Manager. This action will copy the template file from step 1 

into the IP Office template directory. 

  

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Figure 9 – Import Template for SIP Line 

 

In the pop-up window (not shown) that appears, select the folder where the template file was 

copied in step 1. After the import is complete, a final import status pop-up window below 

will appear stating success (or failure). Then click OK to continue. 

 

 

Figure 10 – Import Template for SIP Line successfully 
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3. Create the SIP Trunk from the template: Right-click on Line in the Navigation Pane, then 

navigate to New from Template → Open from file.  

 

 

 

 

 

 

 

 

 

 

F 

 

 

 

 

 

 

 

 

 

 

 

 

 

Figure 11 – Create SIP Line from Template 
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4. Select the Template Files (*.xml) and select the imported template from step 2 at IP Office 

template directory C:\Program Files\Avaya\IP Office\Manager\Templates\. Click Open 

button to create a SIP line from template.  

 
 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Figure 12 – Create SIP Line from IP Office Template directory 
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A pop-up window below will appear stating success (or failure). Then click OK to continue. 

 

 

 

 

 

 

 

 

 

 

 

Figure 13 – Create SIP Line from Template successfully  

 

5. Once the SIP Line is created, verify the configuration of the SIP Lines with the configuration 

shown in Section 5.6.2. 
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5.6.2. Create SIP Line Manually 

To create a SIP line, begin by navigating to Line in the left Navigation Pane, then right-click in the 

Group Pane and select New → SIP Line (not shown).  

On the SIP Line tab in the Details Pane, configure the parameters as shown below: 

• Select available Line Number: 17 

• Set ITSP Domain Name to the domain name of TELUS signaling server (TELUS provided 

this domain name). This field is used to specify the default host part of the SIP URI in the 

To, R-URI fields for outgoing calls  

• Set Local Domain Name to blank  

Note: For the user making the call, the user part of the From SIP URI is determined by the 

settings of the SIP URI channel record being used to route the call (see SIP URI → Local 

URI). For the destination of the call, the user part of the To and R-URI fields are determined 

by dial short codes of the form 9N;/N where N is the user part of the SIP URI 

• Check the In Service and Check OOS boxes 

• Set URI Type to SIP 

• For Session Timers, set Refresh Method to Auto with Timer (sec) to On Demand 

• Set Name Priority to Favor Trunk. As described in Section 5.4, the Default Name 

Priority parameter may retain the default Favor Trunk setting, or can be configured to 

Favor Directory. As shown below, the default Favor Trunk setting was used in the 

reference configuration 

• For Redirect and Transfer, set Incoming Supervised REFER and Outgoing Supervised 

REFER to Always  

Note: TELUS preferred to use SIP REFER for off-net redirection/transfer call during the 

compliance testing. Therefore, both Incoming Supervised REFER and Outgoing 

Supervised REFER are set to Always so that Avaya IP Office always sends SIP REFER. 

TELUS also supported SIP re-Invite for off-net redirection/transfer call (Set both Incoming 

Supervised REFER and Outgoing Supervised REFER to Auto. This is optional setting). 

Avaya IP Office uses the Allow header of the OPTIONS response to determine if the 

endpoint supports REFER. In this case, TELUS responded without Allow: REFER. 

Therefore, Avaya IP Office did not send REFER if Auto is configured. Avaya IP Office does 

not support blind call transfer using REFER with H323 phone over public SIP trunk. In this 

case, the consultative call transfer is used instead 

• Check Outgoing Blind REFER option 

• Default values may be used for all other parameters 

• Click OK to commit then press Ctrl + S to save 
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Figure 14 – SIP Line Configuration  
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On the Transport tab in the Details Pane, configure the parameters as shown below: 

• The ITSP Proxy Address was set to the IP address of TELUS signaling server: 

192.168.158.100 as shown in Figure 1 

• In the Network Configuration area, UDP was selected as the Layer 4 Protocol and the Send 

Port was set to 5060 

• The Use Network Topology Info parameter was set to None. The Listen Port was set to 

5060. Note: For the compliance testing, the Use Network Topology Info field was set to 

None, since no NAT was using in the test configuration.  In addition, it was not necessary to 

configure the System → LAN2 → Network Topology tab for the purposes of SIP trunking. If 

a NAT is used between Avaya IP Office and the other end of the trunk, then the Use Network 

Topology Info field should be set to the LAN interface (LAN2) used by the trunk and the 

System → LAN2 → Network Topology tab needs to be configured with the details of the 

NAT device 

• The Calls Route via Registrar was unchecked. In this certification testing, TELUS did not 

support the dynamic Registration on the SIP Trunk 

• Other parameters retain default values 

• Click OK to commit then press Ctrl + S to save 

 

 

Figure 15 – SIP Line Transport Configuration  

 



 
HV; Reviewed: 

SPOC 7/10/2019 

Solution & Interoperability Test Lab Application Notes 

©2019 Avaya Inc. All Rights Reserved. 

24 of 38                               

TLRIPO11 

 

On the SIP Credentials tab in the Details Pane, click Add button to configure the parameters as 

shown below: 

• User name: p587XXX0308 (TELUS provided this information) 

• Authentication Name: p587XXX0308 (TELUS provided this information) 

• Contact: p587XXX0308 (TELUS provided this information) 

• Password: ******** (TELUS provided this information) 

• Confirm Password: ******** (TELUS provided this information) 

• Expiration (mins): 1 

• Check Registration required option 

• Other parameters retain default values 

• Click OK to commit then press Ctrl + S to save 

 

 

Figure 16 – SIP Line SIP Credentials Configuration 

 

The SIP URI entry must be created to match any DID number assigned to an Avaya IP Office user 

and Avaya IP Office will route the calls on this SIP line. Select the SIP URI tab; click the Add 

button and the New Channel area will appear at the bottom of the pane (not shown). To edit an 

existing entry, click an entry in the list at the top, and click Edit… button. In the example screen 

below, a previously configured entry is edited. 
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A SIP URI entry was created that matched any DID number assigned to an Avaya IP Office user. 

The entry was created with the parameters shown below: 

• Associate this SIP line with an incoming line group in the Incoming Group field and an 

outgoing line group in the Outgoing Group field. This line group number will be used in 

defining incoming and outgoing call routes for this line. For the compliance test, a new line 

group 17 was defined that only contains this line (line 17) 

• Set Max Sessions to the number of simultaneous SIP calls that are allowed using this SIP 

URI pattern 

• Select Credentials to 1: p587XXX0308 

• Check P Asserted ID and Diversion Header options 

• Set the Display and Content of Local URI, Contact, P Asserted ID and Diversion Header 

to Use Internal Data 

• In Field meaning: Set Forwarding/Twinning of Local URI, P Asserted ID and Diversion 

Header to Original Caller 

• Click OK to submit the changes 

 

 

Figure 17 – SIP Line SIP URI Configuration  
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Select the VoIP tab to set the Voice over Internet Protocol parameters of the SIP line. Set the 

parameters as shown below: 

• The Codec Selection can be selected by choosing Custom from the pull-down menu, 

allowing an explicit ordered list of codecs to be specified. The G.711 ULAW 64K and 

G.729(a) 8K CS –ACELP codecs are selected. Avaya IP Office supports these codecs, 

which are sent to TELUS, in the Session Description Protocol (SDP) offer, in that order. 

• Check the Re-invite Supported box 

• Set Fax Transport Support to G.711 from the pull-down menu. Note: TELUS supported 

Fax G.711 pass-through and T38 modes during the compliance testing. For T.38 faxing call, 

IPO sent “m: audio 0“ line in the SDP attribute of T38 re-INVITE, TELUS rejected the call 

with “488 Not Acceptable Here” because TELUS did not support multiple m-lines for the 

T38 re-INVITE. G711 pass-through can be used for faxing (See observation in Section 2.2)  

• Set the DTMF Support to RFC2833 from the pull-down menu. This directs Avaya IP 

Office to send DTMF tones using RTP events messages as defined in RFC2833  

• Default values may be used for all other parameters 

• Click OK to submit the changes 

 

 
 

Figure 18 – SIP Line VoIP Configuration 
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Select the SIP Advanced tab to set the SIP parameters. Set the parameters as shown below: 

• Check Emulate NOTIFY for REFER option (See observation in Section 2.2) 

• Default values may be used for all other parameters 

• Click OK to submit the changes 

 

 

Figure 19 – SIP Line SIP Advanced Configuration 
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5.7. Outgoing Call Routing 

The following section describes the Short Code for outgoing calls to TELUS. 

5.7.1. Short Code 

Define a short code to route outbound traffic on the SIP line to TELUS. To create a short code, 

select Short Code in the left Navigation Pane, then right-click in the Group Pane and select New 

(not shown). On the Short Code tab in the Details Pane, configure the parameters for the new short 

code to be created. The screen below shows the details of the previously administered “9N;” short 

code used in the test configuration. 

• In the Code field, enter the dial string which will trigger this short code, followed by a semi-

colon. In this case, 9N;, this short code will be invoked when the user dials 9 followed by 

any number. 

• Set Feature to Dial. This is the action that the short code will perform. 

• Set Telephone Number to N. The value N represents the number dialed by the user.  

• Set the Line Group ID to the Outgoing Group 17 defined on the SIP URI tab on the SIP 

Line in Section 5.6.2. This short code will use this line group when placing the outbound 

call.  

• Set the Locale to United States (US English). 

• Default values may be used for all other parameters. 

• Click OK to submit the changes. 

 

 
 

Figure 20 – Short Code 9N 
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The feature of incoming calls from mobility extension to idle-appearance FNE (Feature Name 

Extension) is hosted by Avaya IP Office. The Short Code FNE00 was configured with following 

parameters: 

• For Code field, enter FNE feature code as FNE00 for dial tone  

• Set Feature to FNE Service 

• Set Telephone Number to 00 

• Set Line Group ID to 0 

• Set the Locale to United States (US English) 

• Default values may be used for other parameters  

• Click OK to submit the changes 

 

 
 

Figure 21 – Short Code FNE 
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5.8. User  

Configure the SIP parameters for each user that will be placing and receiving calls via the SIP Line 

defined in Section 5.6. To configure these settings, first select User in the left Navigation Pane, then 

select the name of the user to be modified in the center Group Pane. In the example below, the name 

of the user is 0308. Select the SIP tab in the Details pane.   

 

The values entered for the SIP Name and Contact fields are used as the user part of the SIP URI in 

the From and Contact headers accordingly for outgoing SIP trunk calls. They also allow matching of 

the SIP URI for incoming calls without having to enter this number as an explicit SIP URI for the 

SIP line. The example below shows the settings for user 0308. The SIP Name and Contact are set to 

one of the DID numbers assigned to the enterprise provided by TELUS. The SIP Display Name 

(Alias) parameter can optionally be configured with a descriptive name. If all calls involving this 

user and a SIP Line should be considered private, then the Anonymous box may be checked to 

withhold the user’s information from the network. 

 

 
 

Figure 22 – User Configuration 
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One of the H.323 IP Deskphones at the enterprise site uses the Mobile Twinning feature. The 

following screen shows the Mobility tab for User 0308. The Mobility Features and Mobile 

Twinning boxes are checked. The Twinned Mobile Number field is configured with the number to 

dial to reach the twinned mobile telephone, in this case 91613XXX5095. Check Mobile Call 

Control to allow incoming calls from mobility extension to access FNE00 (defined in Section 

5.7.1). Other options can be set according to customer requirements. 

 

 

Figure 23 – Mobility Configuration for User 
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5.9. Incoming Call Route 

An Incoming Call Route maps an inbound DID number on a specific line to an internal extension.  

This procedure should be repeated for each DID number provided by the service provider. To create 

an incoming call route, select Incoming Call Route in the left Navigation Pane, then right-click in 

the center Group Pane and select New (not shown). On the Standard tab of the Details Pane, enter 

the parameters as shown below:  

• Set the Bearer Capability to Any Voice. 

• Set the Line Group ID to the Incoming Group 17 defined on the SIP URI tab on the SIP 

Line in Section 5.6.2. 

• Set the Incoming Number to the incoming DID number on which this route should match. 

• Default values can be used for all other fields.  

 

 
 

Figure 24 – Incoming Call Route Configuration 

 

On the Destination tab, select the destination extension from the pull-down menu of the Destination 

field. In this example, incoming calls to 587XXX0308 on line 17 are routed to Destination 0308 

0308 as below screenshot: 

 

 

Figure 25 – Incoming Call Route for Destination 0308  
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For Feature Name Extension Service testing purpose, the incoming calls to DID number 

587XXX0309 were configured to access FNE00. The Destination was appropriately defined as 

FNE00 as below screenshot: 

 

 

Figure 26 – Incoming Call Route for Destination FNE  

 

For Voice Mail testing purpose, the incoming calls to DID number 587XXX0309 were configured to 

access VoiceMail. The Destination was appropriately defined as VoiceMail as below screenshot: 

 

 

Figure 27 – Incoming Call Route for Destination VoiceMail 

5.10.  Save Configuration 

Navigate to File → Save Configuration in the menu bar at the top of the screen to save the 

configuration performed in the preceding section. 
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6. TELUS SIP Trunk Configuration 
TELUS is responsible for the configuration of TELUS IP Trunking Service Release 2. The customer 

must provide the IP address used to reach the Avaya IP Office LAN2 port at the enterprise. TELUS 

will provide the customer necessary information to configure the SIP connection between Avaya IP 

Office and TELUS. The provided information from TELUS includes: 

• IP address and port number used for signaling or media servers through any security devices 

• DID numbers 

• TELUS SIP Trunk Specification (If applicable) 



 
HV; Reviewed: 

SPOC 7/10/2019 

Solution & Interoperability Test Lab Application Notes 

©2019 Avaya Inc. All Rights Reserved. 

35 of 38                               

TLRIPO11 

 

7. Verification Steps 
The following steps may be used to verify the configuration: 
 

• Use the Avaya IP Office System Status application to verify the state of the SIP connection. 

Launch the application from Start → Programs → IP Office → System Status on the PC 

where Avaya IP Office Manager was installed. Select the SIP Line of interest from the left 

pane. On the Status tab in the right pane, verify the Current State for each channel (The 

following screen-shot shows 2 active calls at the present time). 

 

 

Figure 28 – SIP Trunk status 
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• Use the Avaya IP Office System Status application to verify that no alarms are active on the 

SIP line. Launch the application from Start → Programs → IP Office → System Status on 

the PC where Avaya IP Office Manager was installed. Select Alarm → Trunks to verify that 

no alarms are active on the SIP line. 
 

 

Figure 29 – SIP Trunk alarm 

 

• Verify that a phone connected to the PSTN can successfully place a call to Avaya IP Office 

with two-way audio. 

• Verify that a phone connected to Avaya IP Office can successfully place a call to the PSTN 

with two-way audio.  

• Use a network sniffing tool (e.g., Wireshark) to monitor the SIP signaling between the 

enterprise and TELUS. The sniffer traces are captured at the LAN2 port interface of the 

Avaya IP Office. 
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8. Conclusion 
TELUS passed compliance testing excepting the limitation in Section 2.2. These Application Notes 

describe the procedures required to configure the SIP connections between Avaya IP Office and the 

TELUS system as shown in Figure 1. 

9. Additional References 
 

[1] Administering Avaya IP Office Platform with Manager, Release 11.0, Issue 17a, August 2018. 

[2] Deploying IP Office Essential Edition IP Office™ Platform 11.0, 15-601042 Issue 33j - 

(Thursday, September 13, 2018). 

[3] Avaya IP Office™ Platform Release 11.0 – Release Notes / Technical Bulletin General 

Availability 

 

Product documentation for Avaya products may be found at: http://support.avaya.com 

 

 

Product documentation for TELUS SIP Trunking may be found at 

http://www.TELUS.com/business/voice-networks/ip-trunking/ 

 

 

 

   

http://support.avaya.com/
http://www.telus.com/business/voice-networks/ip-trunking/
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